CONFERENCE POSTERS

Lindsay McNiff
Learning & Instruction Librarian
Agenda

• Why a conference poster?
• Poster conventions
• A recent trend (Mike Morrison)
• Making posters
  • How to set up a basic poster in PowerPoint
  • Some tips on font, colours, etc
  • Using images and graphs
• Presenting posters – a few ideas
Why a conference poster?

• Alternative to a conference presentation

• Visual communication of scholarly ideas
  • Will you be including a lot of amazing charts?
  • Is your research a work-in-progress?

• Facilitates interaction with other researchers
  • Networking, conversing

• People are more engaged when standing
Poster sessions

Image: http://upload.wikimedia.org/wikipedia/commons/7/78/GDog_Poster_Session.jpg

Image: http://www.iucr.org/__data/assets/image/0017/3518/Poster-Sesion.gif
Common scientific poster sections

**note that these sections might not be appropriate for your poster!**

• Title (catchy, 2 lines max)
• Background (about your topic) ➞ Abstract.
• Methods (what you did. Consider photos.)
• Results (what you found)
• Discussion/Conclusions (what it means)
• Citations (5-10)
• Acknowledgements

Abstract.

Should be interesting and understandable for laypeople.
Common scientific poster sections
**note that these sections might not be appropriate for your poster!**

- Title (catchy, 2 lines max)
- Background (about your topic) ≠ Abstract
- Methods (what you did. Consider photos.)
- Results (what you found)
- Discussion/Conclusions (what it means)
- Citations (5-10)
- Acknowledgements

Consider other more interesting titles that capture these same ideas
Title: catchy and yet descriptive

“D.I.Y.” – how they did this on the cheap

“Assess” – description, using graphs, of student uptake

“Promo” – how they promoted the service

“Tips” – key takeaways to help others plan similar initiatives
COMMUNITY ENGAGED SCHOLARSHIP AT LAURIER

What is it?

"Mutually beneficial partnerships between communities & universities for learning, knowledge co-creation & mobilization."

Faculty survey says...

- 62% have time for CES
- 12% feel adequately rewarded
- 42% would like more support

Benefits

- Enhances learning
- Connects teaching to everyday life
- Unique research & publications
- Transformational change
- Personal & societal change
- Stronger relationships

For more info visit: www.wlu.ca/csl/ces

Challenges

- Integration of on and off-campus learning
- Time & cost
- Unclear expectations
- Support for students & faculty

Students

- CES interest by the numbers
  - 58% say they have the time
  - 63% already do other volunteering
  - 72% are motivated to make a difference in their community
  - 75% want to pay a small extra fee for a CES course

Actions

- Reward CES efforts as part of hiring, tenure, and promotion
- Coordinate CES efforts among departments
- Match community needs and university resources
- Designate CSL courses on the academic calendar
- Develop policy on CES

Benefits

- 66% of students report increased learning and skills
- 78% of students report increased critical thinking
- "I've never even heard the phrase that didn't change me. I've never worked and didn't a placement where it hasn't come out with something."

Teaching and Learning with Scholarly Digital Storytelling

POSSIBILITIES

- Reimagining academic research and scholarly communication
- Promote inquiry based, authentic learning
- Higher education
- Empower students to share academic work in new ways

RESEARCH QUESTIONS

- Does participation in digital storytelling influence students' academic research?
- Does participation in digital storytelling facilitate student communication of academic work beyond the classroom?
- Does participation in digital storytelling influence student attitudes toward development of digital skills?

INTERVIEWS WITH STUDENTS & FACULTY

- 19 institutions (large, small, public, private, research, liberal arts)
- 5 Countries
- 35 Students (graduate & undergraduate)
- 77 Faculty
Some “rules”

- Keep it concise – 1000 words or less (5-10 min to read)
- Background: white or light (or at least contrast)
- Landscape or portrait – may depend on conference requirements
- Think about your audience when choosing terminology

- Use white space
- Font (average standards):
  - Title: 100
  - Subtitle (author name, etc): 80
  - Section headings: 50 – 72
  - Body text: 24 – 48
- Embrace logical arrangement
ABSTRACT:
One ignored benefit of space travel is the potential elimination of obesity, a chronic problem for a growing majority in many parts of the world. In space, when an individual is in a condition of zero gravity, weight is eliminated. In space, one could convert nutritionally bad, but fattening food and retain even gain all gram, and the only side effect would be the need to upgrade one's stress management-system capacity. But because many dietary schemes start as very good theories only to be found to be either harmful, we tested our predictions with a long-term experiment in a colony of Guinea pigs (Cavia porcellus) maintained on the International Space Station. Just before the experiment, the pigs were housed separately and given unlimited amounts of high-calorie food pellets. Fresh fruits and vegetables were not available in space as were not offered. Every 30 days, each Guinea pig was weighed. After 5 years, we found that individuals on average weighed nothing. In addition to weighing nothing, no weight appeared to be gained over the duration of the protocol. If space continues to be gravity-free, and we believe that assumption is sound, we believe that something unusual — and to all risk of overweight — space would be a testing cure.

INTRODUCTION:
The current obesity epidemic started in the early 1980s with the invention and proliferation of instant noodles and related microwavable meals. However, traditional weaning methods failed families. After 30 years of weight loss and related strategies (i.e., caloric restriction), but because many dietary schemes started as good theories only to be found to be either harmful, we tested our predictions with a long-term experiment in a colony of Guinea pigs (Cavia porcellus) maintained on the International Space Station. The pigs were housed separately and given unlimited amounts of high-calorie food pellets. Fresh fruits and vegetables were not available in space as were not offered. Every 30 days, each Guinea pig was weighed. After 5 years, we found that individuals on average weighed nothing. In addition to weighing nothing, no weight appeared to be gained over the duration of the protocol. If space continues to be gravity-free, and we believe that assumption is sound, we believe that something unusual — and to all risk of overweight — space would be a testing cure.

RESULTS:
Mean weight of pigs in space was 0.0000 = 0.0000 g. Some individuals weighed less than zero, some were, but these variations were due to reaction to the dust tape, we believe, which caused them to be deemed grossly bailed against the force plate in the balance. Individuals on the Earth, the control, gained about 240 g (p = 0.0000). Males and females gained a similar amount of weight on Earth (no main effect of sex), and size at any point during the study was related to starting size (which was monitored at the conclusion of the YODAW). Both Earth and space pigs developed subcutaneous double chins and were lethargic at the conclusion of the study.

CONCLUSIONS:
Our view that weight and weight gain would be zero in space was confirmed. Although we have not replicated this experiment on larger animals or primates, we believe that our results would be mirrored in other rodent organisms. We are currently in the process of obtaining necessary human trial permissions and should have our planned experiment initiated within 80 years, pending expedited review by local and Federal labs.

LITERATURE CITED:
NASA. 1992. Project STS-10: Guinea Pig. Looked (internal memo).

Acknowledgements:
I am grateful for generous support from the National Research Foundation, Black Hole Diet Plans, and the High Fructose Sugar Association. Transport funds were furnished by Space EXES, the operators of these conducted spaceflight startups. I am also grateful for comments on early drafts by Mañana Athletic Club, Corpus Christi, USA. Finally, sincere thanks to the Guy Foundation for generously donating animal care after the conclusion of the study.
Recent trend: Morrison method

• Concerned about the inefficiency of poster sessions – blames this on poster design

• 3 main goals
  • Maximize the amount of insight transferred to attendees
  • Keep the good stuff
  • Make it easy for grad students and scientists to achieve this

• If you can only put one thing on a poster, make it the main finding – *in plain language*

• This method lets viewers decide how they want to engage with the poster
Template or from scratch?

• Lots of templates available
  • [http://colinpurrington.com/tips/academic/posterdesign#templates](http://colinpurrington.com/tips/academic/posterdesign#templates)
  • Mike Morrison template: [https://osf.io/ef53g/](https://osf.io/ef53g/)

• Pimp My Poster on Flickr (examples only) [https://www.flickr.com/groups/pimpmyposter/](https://www.flickr.com/groups/pimpmyposter/)
How big?

- Size can depend on conference requirements
- 36 inches on one dimension is very standard

https://libraries.dal.ca/services/photocopying-printing.html
The poster must be created at the same size at which it will be printed.
Let’s get started!

- Open this URL
  http://dal.ca.libguides.com/ResearchBootcamp/presentationfiles
- Find Week 3: Conference posters
- Open PowerPoint
- Set the layout to “Blank” (or just quietly remove any boxes on your screen)
Gridlines are helpful

- Click the **View** tab
- Refer to “Step 1” on handout
- Create a 3-column layout.
Let’s set up our dimensions! Step 2

• Click the **Design** tab

• Click **Slide Size**; open **Custom Slide Size** or **Page Setup** on Mac

• Format like so (48 x 36), landscape
  
  (121.92 x 91.44 in cm)
This does not matter. Click either “Maximize” or “Ensure fit.” Do NOT click “Cancel.”

Set your layout to a blank slide: 

Home tab -> Layout -> Blank
You should have something like this. If you don’t have this exactly, don’t panic. The gridlines are helpful but not necessary.
Or, if you want to try the Morrison route, move your column lines a bit closer to the edge.
Fonts interlude

- Do not use more than 2 fonts. Try to use complementary fonts.
- Debate:
  - Sans for headings; serif for body?
  - Sans for the whole thing?

I mean, there are serifs...

And then there are serifs!!!
Fonts interlude

• Do not use more than 2 fonts. Try to use complementary fonts.

• Debate:
  • Sans for headings; serif for body?
  • Sans for the whole thing?

• Colour: black is usually best for body font

• Titles & headings: **bold** OR *underlined*. **NOT BOTH**.

• AVOID ALL CAPS

• Size: 100 | 50 – 72 | 24 – 48 (MINIMUM)

• Use sentence case for your headings! Try it!
From wine cork to garden gnome: An exploratory study
Dear Mum,

I Am Going To Leave The Spare Key Under The Flower Pot In The Front Garden So That If You Arrive Before I Get Home From Work You Can Get In. Please Feed Fluffy If She Looks Hungry Or Meows A Lot When You Open The Door. Tuna Is Her Favourite Flavour.

Example from [http://www.stickycontent.com/blog/are-you-team-title-case-or-team-sentence-case.php](http://www.stickycontent.com/blog/are-you-team-title-case-or-team-sentence-case.php)
Let’s give this thing a title!:
Step 4

- Add a text box across the top (Insert tab -> Shapes -> Select a shape for your title box)

- In 100ish point (your choice of font), create a title

- Add your name & affiliation, slightly smaller, underneath the title

- Change the weight of the line around the box
  - Click on the box
  - Click Format (or Shape Format) tab
  - Open Shape Outline menu and choose the weight
In the Morrison method, your title would go along the left side.

The main finding is in the centre column. The text size used in this example is 180.

Wine corks make tiny but powerful garden gnomes.
Let’s create some boxes!

• Using your columns as a guideline, create boxes for your sections. Use Insert -> Shapes.

• **50-72 point font** for the section headings (use these or others appropriate to your topic):
  • Background
  • Methodology
  • Results (largest section)
  • Discussion
  • References
  • Acknowledgements

• Insert dummy text at 28 point in some of the boxes

• Once you have inserted text, adjust the margins as per the handout
From wine cork to garden gnome: An exploratory study
Lindsay McNiff, Dalhousie University

Background

Methods

Results

Discussion

References

Acknowledgements
In the Morrison method, you can still insert boxes for your sections and include dummy text.

Wine corks make tiny but powerful garden gnomes
Colour scheme

- Online colour wheels are your friend
- Try Adobe Color Wheel
- Browse colour schemes or create your own
Let’s colour it!

PC: “More Colours,” -> “Custom”

Mac: “More Colours,” click 2\textsuperscript{nd} tab
From wine cork to garden gnome: An exploratory study
Lindsay McNiff, Dalhousie University

Background

Results

Methods

Discussion

References

Acknowledgements
In this example, I changed the font from black to white to contrast with the background.
Images

- Images should be **meaningful**
- Should be large. Take your own photos!
- When searching in Google images, filter for size (Large)
- Add a thin grey or black border to photographs on your poster
- Material with permissive licenses:
  - Google Image search – Use “Tools” function to filter by license
  - thenounproject.com
  - iconfinder.com
  - [http://commons.wikimedia.org/wiki/Main_Page](http://commons.wikimedia.org/wiki/Main_Page)
- Caption your images
University logo

• You may want to include one

“Unlike boring institutional logos, adding a research-related image to the top of a poster can draw in visitors.”
– C. Purrington

Image: https://colinpurrington.com/tips/poster-design/protips
Graphs

- Graphs & charts should be created in Excel and then copied into PowerPoint
- Excel templates are available
- Check out Watch Your Figures for a run-down of which types of graphs are best suited to which types of information
- Infographics
  - Easel.ly
  - Piktochart
  - Infogr.am
- Word clouds
  - http://www.wordle.net/
A few final adds...

• Add the Dal logo to your poster


• Try adding the following:
  • A photo with a permissive license
  • One of the sample graphs (copy/paste) from the website (*Bonus: adjust the colours on the graph to fit your scheme)
From wine cork to garden gnome: An exploratory study
Lindsay McNiff, Dalhousie University

Background

Set of parameters were used in a machine learning algorithm to predict the outcome of a wine corking process. The results were compared with actual corking data. The correlation was strong, indicating that the model accurately predicts corking outcomes.

Methods

A series of experiments were conducted to evaluate the effects of different corking techniques on wine质量. The results showed that the traditional method produced the best quality wine, followed by the automated method. Manual corking resulted in the poorest quality wine.

Results

![Graph showing results](image)

Discussion

The results of this study suggest that the traditional corking method is the most effective. However, further research is needed to determine the long-term effects of corking technique on wine quality.

References


Acknowledgements

This research was supported by a grant from the National Wine Research Institute. The authors would like to thank the participants for their cooperation.

Dalhousie University
In Morrison’s method, the right side it “just for you.” You can use this part of the poster to include extra data to help support your work.

A QR code is included for those who want to read more.
Finish it off!

- Remove the gridlines
- Save it as a PDF
- And...
From wine cork to garden gnome: An exploratory study
Lindsay McNiff, Dalhousie University

Background

Methods

Results

Discussion

References

Acknowledgements
From wine cork to garden gnome: An exploratory study
Lindsay McNiff, Dalhousie University

Background

Methods

Results

Discussion

References

Acknowledgements
From wine cork to garden gnome: An exploratory study

Wine corks make tiny but powerful garden gnomes
Presenting your poster

- Prepare a 2-minute lightning talk
- If more listeners arrive mid-way through, don’t start again
- Candy is a great idea
- Ask your friends to hang around
- Bring double-sided handouts
  - Copy of your poster on one side
  - Complete bibliography and further information on other side
  - Put your poster online and create a short link for viewers to photograph
- Bring business cards (a name tag is also a good idea)
**Consider interactivity**

- Create comment cards or a feedback sheet
- Try lift-up flaps (especially when only some of your audience will find the info under the flap interesting.
- Make a 3D model (if it makes sense)
- Allow others to contribute to your poster (sticky notes? Whiteboard?)
- Bring an iPad (or embed it in your poster) or laptop
- Make it easy for others to leave business cards
students are given the opportunity to apply their knowledge in new and authentic situations, and in environments that are democratic, flexible and fluid.

**Process**

Active learning was the focus of an EUA initiative in 2018 which brought staff and students together from Higher Education institutions in 10 countries to exchange best practice on how to promote active learning and encourage the co-creation of learning with students. This poster captures their experiences regarding active learning, and the challenges and enablers relating to its promotion in Higher Education as identified by the group.

**What are your thoughts on active learning?**

**CONCERNS**

To what extent do my students have the required skills to direct their own learning?

How much preparatory work is required to make active learning work in my classroom, and will this work with a large class of first years?

Teachers remain the gatekeepers of education so how can students really be equal partners in the learning?

Remember...

“Data” is a plural word.

The data *is* not compelling.

The data *are* compelling
QUESTIONS?
Resources consulted

• Adam Reed, Producing an Academic Poster https://www.youtube.com/watch?v=GJwcVWs6LCc4
• Chris Woolston: Conference presentations: Lead the poster parade http://www.nature.com/nature/journal/v536/n7614/full/nj7614-115a.html
• Colin Purrington: http://colinpurrington.com/tips/academic/posterdesign
• How to create a poster in PowerPoint for a poster conference (MAC or PC) - https://www.youtube.com/watch?v=mCJ71rISBcA UH Manoa LIS Web Team
• Inspired by “Posters with Punch Using PowerPoint” – workshop at U of T; Karen Smith, ginger coons
• Mike Morrison “How to create a better research poster in less time” https://www.youtube.com/watch?v=1RwJbhkCA58
• Sam Birks: tweet re. poster on improving educational poster readability https://twitter.com/BirksMD/status/1018377086623461377/photo/1 (design credit for example poster in this PowerPoint)